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Overview 
You can quickly begin using your Keithley Instruments Model 4210-CVU Capacitance Voltage Unit by following 
the steps in this Quick Start Guide (QSG). For detailed information about the 4210-CVU, refer to the Complete 
Reference CD-ROM that came with your Model 4200-SCS Semiconductor Characterization System. 

Follow the steps outlined below and detailed in the following pages to begin using your 4210-CVU: 

• Step 1: Unpack your 4200-SCS.
• Step 2: Make basic system connections (power cord, keyboard, and optional printer).
• Step 3: Connect a test fixture to the 4200-SCS (4210-CVU card preinstalled).
• Step 4: Power up and log on.
• Step 5: Start the KITE software and select the cv-cap test in the default project.
• Step 6: Define your test.
• Step 7: Run the cv-cap test.
• Step 8: View the data sheet.
• Step 9: View the graph.
• Step 10: Print and export data.

The example in this QSG uses the default project and runs the cv-cap test. To select a different project or test, 
you must modify the procedures as appropriate. Figure 1 shows the Keithley Interactive Test Environment 
(KITE) window after the default project and cv cap test are selected. 

Figure 1: KITE interface with the cv-cap test selected in the default project 

KITE Workspace Selected Test Project Navigator Toolbar 

http://www.tek.com/keithley
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Step 1: Unpack your 4200-SCS 
The box contains: 
• 4200-SCS Semiconductor Characterization System, with the 4210-CVU card integrated into the mainframe.

How to lift the 4200-SCS: 

• Lift from the bottom, not from the front bezel.

• Set it on a bench or install it in a rack using the optional slide rack-mounting kit.

• Keyboard with built-in pointing device
• Two triax cables for each source-measure unit (SMU)
• Four red SMA to SMA cables for the 4210-CVU
• Connectors: Four SMA to BNC adapters; 2 BNC tees
• Y-Cable: Use to connect the keyboard to the mainframe
• Power cord
• Model 4200-SCS KTE Interactive CD-ROM
• Model 4200-SCS Complete Reference CD-ROM

Step 2: Make basic system connections (power cord, keyboard, and optional 
printer) 

Basic system connections to the 4200-SCS (shown in Figure 2) include the keyboard (which has a built-in 
pointing device), the supplied power cord, and an optional printer. If you are using a USB printer, connect it 
to the USB port. 

Plug the female end of the supplied power cord into the 4200-SCS. Do not connect the male 
end to line power at this time. Steps 2 and 3 in this Quick Start Guide must be performed with 
the line power disconnected. 

Figure 2: System connections 
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Step 3: Connect a test fixture to the 4200-SCS (4210-CVU card preinstalled) 
Figure 3 shows how to connect a BNC test fixture to the 4200-SCS. The red SMA cables and BNC 
adapters are supplied with the 4210-CVU card. 

Figure 3: DUT test fixture connections to the 4210-CVU 

 

Step 4: Power up and log on 
1. Make sure the POWER switch is in the OFF (out) position. The POWER switch is on the front panel in the 

lower right corner. 

2. Plug the male end of the line cord into a properly grounded AC line power receptacle. 

3. Turn on the 4200-SCS by pushing in the POWER switch to the ON (in) position. 

4. At the KIUSER prompt, press ENTER. There is no password for this account. 

When first starting a KTE Interactive software tool, you must answer "Yes" to an on-screen license 
agreement. Answering "No" makes your system nonfunctional until you reinstall the software. 
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Step 5: Start the KITE software and select the cv-cap test in the default 
project 

1. Start the KITE software by double-clicking the KITE icon on the Microsoft® Windows® desktop (see 
Figure 4). 

Figure 4: The KITE icon 

 

When KITE starts, the default project will open automatically. If a different project opens, perform the three 
steps in Figure 5 to open the default project. The Project Navigator for the default project is shown in  
Figure 1. 

If the Project Navigator is not displayed when KITE is started, click the View menu and select the 
Project Navigator item. The View menu is located on the upper left side of the menu bar in the KITE 
window. 

Figure 5: Open default project 

 

When browsing, use the following directory path to locate the default.kpr project file: 
C:\S4200\kiuser\Projects\default\default.kpr 

1 From the File menu, 
click Open Project 

2 Use the browser to select 
the default project 

3 Click Open to open 
the default project 

Double-click to start KITE 
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2. Select the cv-cap test, as shown in Figure 6. 
Figure 6: Default project in Project Navigator: Selecting the cv-cap test 

 
 

 

 

Step 6: Define your test 
The test is defined from the test Definition tab shown in Figure 7. As shown in the tab, the device in this 
example is connected to the CVH1 and the CVL1 terminals of the 4210-CVU. In this test, the DC bias is swept 
from –5 V to 5 V in 0.2 V steps, with a 1 MHz capacitance measurement made at each step. 

1. You can change the setup for the cv-cap test. A settings window is displayed by clicking the appropriate 
FORCE MEASURE bar, as shown in Figure 7. Figure 8 shows the Forcing Functions / Measure Options 
window for cv-cap setup. 

Figure 7: cv-cap Definition tab: How to display a setup window for the CVU instrument 

 

Double-click cv-cap to select the 
test 

 

The checkbox for the cv-cap test 
must be checked in order to run 
the test. If unchecked, click the 
checkbox to insert a  

B. Click to set up the CVH1 terminal 
settings A. Select Definition tab 
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Figure 8: Setup for CVU pin CVH1 

 

2. After making any changes to the test definition, click the Save All button on the toolbar to save the settings 
(see Figure 9). 

Figure 9: The Save All button 
 

 

Step 7: Run the cv-cap test 
1. In the Project Navigator (see Figure 6), make sure the cv-cap test is highlighted and the checkbox is 

checked. 
2. On the toolbar, click the green Run Test button to run the test one time (see Figure 10).  

Figure 10: The Run Test button 
 

 

While the test is running, the Run Test button turns gray and the Abort Test button turns red. In addition, the 
MEASURING indicator on the lower right corner of the front panel is on while the test is running. When the test is 
finished, the Run Test button turns green. 

Click Run Test 
to start test. 

Click Save All to 
save settings. 

These parameters 
set up the DC bias 
sweep 

This pull-down menu 
selects the format of 
the measured data 
(e.g., the Measure 
Model) 

Key AC 
settings 



Model 4210-CVU Quick Start Guide 

PA-952 Rev. B / December 2016 7 

Troubleshooting hints 
A selected test will not run if the Run Test button is not green. Here are a few reasons why the Run Test button 
will not be green: 

• A test is still running. 
• The checkbox for the test is not checked (see Figure 6). 
• Changes to the test setup were not saved (see Step 6B). 

If a selected test still will not run, click the Status tab for the test. This tab provides status information for  
the test. 

Step 8: View the data sheet 
The data sheet for the cv-cap test is displayed by clicking the Sheet tab for the test. Use the tabs at the bottom 
of the Sheet to display the data type. A sample data sheet for the cv-cap test is shown in Figure 11. 

Figure 11: Sample data sheet for the cv-cap test 

 
 

To select more than one sheet for selective printing, hold down the Ctrl key and then click the tab. 
See Step 10 to print Sheet data. 

Click to display 
Data Sheet 

Click to display 
Calc Sheet 

Click to display 
Settings Sheet 

Click to export data 
(see Step 10) 
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Step 9: View the graph 
The graph for the cv-cap test is displayed by clicking the Graph tab for the test. A sample graph for the cv-cap 
test is shown in Figure 12. Notice that the extracted NOISE parameter is included on the screen.  

The Graph Settings menu (shown in Figure 13) was used to select the Legend box and change series colors. 

Figure 12: Sample graph for the vds-id test 

 

Figure 13: Graph Settings menu 

 

To display the Graph Settings menu: Right-click 
your mouse anywhere in the graph area. 

   OR 

From the Tools menu, select Graph...Settings. 

 

Use the Data 
Variables properties 
dialog box to display 
extracted parameters 
– NOISE in this case 
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Auto Y-axis 
By default, the Y-axis does not automatically scale. 

To automatically achieve optimum resolution for the Y-axis, select auto scale as follows: 
1. Right-click anywhere on the graph to display the graph settings menu shown in Figure 13. 
2. In the menu, click Auto Properties to display the Axis Properties window. 
3. Click the Y1 Axis tab, and then click Auto Scale to select the box for Auto. 
4. Click OK to close the window and enable auto scale for the Y-axis. 

Step 10: Print and export data 

Printing Sheet data 
1. In the KITE workspace, click the Sheet tab to display test data. You can selectively print the Data sheet, 

Calc sheet, and the Settings sheet. Figure 11 and the NOTE that follows it show how to select sheets for 
printing. 

2. From the FILE menu (at the upper left side of the KITE window), select the Print option. 
3. In the Print setup window, there are two print options. You can print the Selected Sheets (Data, Calc, or 

Sheet) or the Entire Workbook (Data, Calc, and Sheet). 
4. In the Print setup window, click OK to print the data. 

Printing the graph 
1. In the KITE workspace, click the Graph tab to display the graph. 
2. From the FILE menu (at the upper left side of the KITE window), select the Print option. 
3. In the Print setup window, click OK to print the graph. 

Exporting data into a Microsoft® Excel-compatible worksheet 
1. In the KITE workspace, click the Sheet tab to display the test data. 
2. In the Sheet tab, click the Save As button, as shown in Figure 11. 
3. From the Save As setup window, specify a file name and path and click Save. The default directory path 

for exporting data is C:\S4200\kiuser\export. 

Additional projects for the 4210-CVU 
The following additional projects have been created for the 4210-CVU are in the “_CV” folder in the Projects 
directory: 

CVU_BJT  CVU_Capacitor CVU_InterconnectCap  

CVU_ivcvswitch CVU_lifetime CVU_MobileIon  

CVU_MOScap CVU_MOSFET CVU_nanowire 

CVU_PNjunction CVU_PVcell  

To open one of the above project plans: 
4. Click File at the top of the Keithley Interactive Test Environment (KITE) window. 
5. Select Open Project from the list. 
6. In the Open KITE Project File window, navigate back (up one level) to the Projects folder. 
7. Double-click the _CV folder. 
8. Open the CVU project. 



Model 4210-CVU Quick Start Guide 

10 PA-952 Rev. B / December 2016 

 

 Safety precautions 
The following safety precautions should be observed before using this product and any associated instrumentation. Although 
some instruments and accessories would normally be used with nonhazardous voltages, there are situations where hazardous 
conditions may be present. 

This product is intended for use by qualified personnel who recognize shock hazards and are familiar with the safety precautions 
required to avoid possible injury. Read and follow all installation, operation, and maintenance information carefully before using 
the product. Refer to the user documentation for complete product specifications. 

If the product is used in a manner not specified, the protection provided by the product warranty may be impaired. 
 

The types of product users are: 

Responsible body is the individual or group responsible for the use and maintenance of equipment, for ensuring that the 
equipment is operated within its specifications and operating limits, and for ensuring that operators are adequately trained. 

Operators use the product for its intended function. They must be trained in electrical safety procedures and proper use of the 
instrument. They must be protected from electric shock and contact with hazardous live circuits. 

Maintenance personnel perform routine procedures on the product to keep it operating properly, for example, setting the line 
voltage or replacing consumable materials. Maintenance procedures are described in the user documentation. The procedures 
explicitly state if the operator may perform them. Otherwise, they should be performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and repair products. Only properly trained 
service personnel may perform installation and service procedures. 
 

Keithley Instruments products are designed for use with electrical signals that are measurement, control, and data I/O 
connections, with low transient overvoltages, and must not be directly connected to mains voltage or to voltage sources with 
high transient overvoltages. Measurement Category II (as referenced in IEC 60664) connections require protection for high 
transient overvoltages often associated with local AC mains connections. Certain Keithley Instruments measuring instruments 
may be connected to mains. These instruments will be marked as category II or higher. 

Unless explicitly allowed in the specifications, operating manual, and instrument labels, do not connect any instrument to mains. 

Exercise extreme caution when a shock hazard is present. Lethal voltage may be present on cable connector jacks or test 
fixtures. The American National Standards Institute (ANSI) states that a shock hazard exists when voltage levels greater than 
30 V RMS, 42.4 V peak, or 60 VDC are present. A good safety practice is to expect that hazardous voltage is present in any 
unknown circuit before measuring. 

Operators of this product must be protected from electric shock at all times. The responsible body must ensure that operators 
are prevented access and/or insulated from every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect themselves from the risk of electric shock. 
If the circuit is capable of operating at or above 1000 V, no conductive part of the circuit may be exposed. 
 

Do not connect switching cards directly to unlimited power circuits. They are intended to be used with impedance-limited 
sources. NEVER connect switching cards directly to AC mains. When connecting sources to switching cards, install protective 
devices to limit fault current and voltage to the card. 

Before operating an instrument, ensure that the line cord is connected to a properly-grounded power receptacle. Inspect the 
connecting cables, test leads, and jumpers for possible wear, cracks, or breaks before each use. 

When installing equipment where access to the main power cord is restricted, such as rack mounting, a separate main input 
power disconnect device must be provided in close proximity to the equipment and within easy reach of the operator. 
 

For maximum safety, do not touch the product, test cables, or any other instruments while power is applied to the circuit under 
test. ALWAYS remove power from the entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, such as installing or removing jumpers. 
 

Do not touch any object that could provide a current path to the common side of the circuit under test or power line (earth) 
ground. Always make measurements with dry hands while standing on a dry, insulated surface capable of withstanding the 
voltage being measured. 

For safety, instruments and accessories must be used in accordance with the operating instructions. If the instruments or 
accessories are used in a manner not specified in the operating instructions, the protection provided by the equipment may be 
impaired. 
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Do not exceed the maximum signal levels of the instruments and accessories. Maximum signal levels are defined in the 
specifications and operating information and shown on the instrument panels, test fixture panels, and switching cards. 

When fuses are used in a product, replace with the same type and rating for continued protection against fire hazard. 

Chassis connections must only be used as shield connections for measuring circuits, NOT as protective earth (safety ground) 
connections. 

If you are using a test fixture, keep the lid closed while power is applied to the device under test. Safe operation requires the use 
of a lid interlock. 

If a  screw is present, connect it to protective earth (safety ground) using the wire recommended in the user documentation. 

The  symbol on an instrument means caution, risk of danger. The user must refer to the operating instructions located in the 
user documentation in all cases where the symbol is marked on the instrument. 

The  symbol on an instrument means caution, risk of electric shock. Use standard safety precautions to avoid personal 
contact with these voltages. 

The   symbol on an instrument shows that the surface may be hot. Avoid personal contact to prevent burns. 

The  symbol indicates a connection terminal to the equipment frame. 

If this  symbol is on a product, it indicates that mercury is present in the display lamp. Please note that the lamp must be 
properly disposed of according to federal, state, and local laws. 

The WARNING heading in the user documentation explains dangers that might result in personal injury or death. Always read 
the associated information very carefully before performing the indicated procedure. 

The CAUTION heading in the user documentation explains hazards that could damage the instrument. Such damage may 
invalidate the warranty. 

Instrumentation and accessories shall not be connected to humans. 

Before performing any maintenance, disconnect the line cord and all test cables. 

To maintain protection from electric shock and fire, replacement components in mains circuits — including the power 
transformer, test leads, and input jacks — must be purchased from Keithley Instruments. Standard fuses with applicable national 
safety approvals may be used if the rating and type are the same. The detachable mains power cord provided with the 
instrument may only be replaced with a similarly rated power cord. Other components that are not safety-related may be 
purchased from other suppliers as long as they are equivalent to the original component (note that selected parts should be 
purchased only through Keithley Instruments to maintain accuracy and functionality of the product). If you are unsure about the 
applicability of a replacement component, call a Keithley Instruments office for information. 

Unless otherwise noted in product-specific literature, Keithley Instruments instruments are designed to operate indoors only, in 
the following environment: Altitude at or below 2,000 m (6,562 ft); temperature 0 °C to 50 °C (32 °F to 122 °F); and pollution 
degree 1 or 2. 

To clean an instrument, use a damp cloth or mild, water-based cleaner. Clean the exterior of the instrument only. Do not apply 
cleaner directly to the instrument or allow liquids to enter or spill on the instrument. Products that consist of a circuit board with 
no case or chassis (e.g., a data acquisition board for installation into a computer) should never require cleaning if handled 
according to instructions. If the board becomes contaminated and operation is affected, the board should be returned to the 
factory for proper cleaning/servicing. 

Safety precaution revision as of March 2016. 


	Overview
	Step 1: Unpack your 4200-SCS
	Step 2: Make basic system connections (power cord, keyboard, and optional printer)
	Step 3: Connect a test fixture to the 4200-SCS (4210-CVU card preinstalled)
	Step 4: Power up and log on
	Step 5: Start the KITE software and select the cv-cap test in the default project
	Step 6: Define your test
	Step 7: Run the cv-cap test
	Troubleshooting hints

	Step 8: View the data sheet
	Step 9: View the graph
	Auto Y-axis

	Step 10: Print and export data
	Printing Sheet data
	Printing the graph
	Exporting data into a Microsoft® Excel-compatible worksheet

	Additional projects for the 4210-CVU


